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Fixes & Enhancements for Gorilla v3.1.0 
 
List of Features 

 

1. Element Linking: Now link one element to another. When you move that element to a 
breakdown sheet, all linked elements to that element will also move to the breakdown 
sheet. For example, if you link GUN, BLACK HOOD and KNIFE to the element: BAD MAN; 
every time you add the element BAD MAN to a breakdown sheet, all linked elements will 
also be automatically added to that breakdown sheet. 

2. Category Budget Report: In Gorilla 3 you can attach a value to any element, before you 
add that element to your budget. Now you can run a report that adds all your values for 
your elements. 

3. Actor Blackout Report: You can now attach blackout dates to an actor. Then you can run 
a report which shows you if the actors’ blackout dates conflict with the shooting 
schedule. 

4. Canadian Rates: The Ratebook now comes pre-loaded with hundreds of Canadian rates. 

 
Fixes & Enhancements for Gorilla v3.0.9 

 

List of Fixes/Enhancements 
 

1. If you saved a schedule without any elements (cast members, props, etc.) it would not be 
able to load. This has been fixed. 

2. Adding a transaction record to Accounting broke in v3.0.8. This has been fixed. 

 
 

Fixes & Enhancements for Gorilla v3.0.8 
 

List of Fixes/Enhancements 
 

1. The Crew Call Sheet did not print properly. This has been fixed. 

2. One-Line Schedule report now has banners for Start of Day. Increased room for 3rd line of 
description so it won’t get cut off. 

3. Shooting Schedule report now has banners to display Start of Day. 

4. Before running a Day out of Days report, shoot days are automatically updated. 



 

 

5. When attaching an account (Accounting module) to a second budget, then deleting the first 
budget, both accounts were deleted. This has been fixed. 

6. The Find Mismatches report in the budget module now displays the proper mismatched 
information. 

7. When running a Shot List report, it was possible to see breakdowns from another project. 
This has been fixed. 

8. When saving a schedule, in certain situations all elements for all projects were saved to the 
saved schedule file. This has been fixed. 

9. Enhanced Budget Balance Report. 

10. The preference Disable CUME display in Budget Preferences, if turned on, now improves 
budget screen redraw.    

 
 
Fixes & Enhancements for Gorilla v3.0.6 

 

List of Fixes/Enhancements 
 

1. When deauthorizing Gorilla either manually, through the internet or by change to the 
network (wireless change, etc.), Gorilla would not let you have a 5-day grace period to 
reauthorize, but would lock you out of the program entirely if not immediately 
authorized. Now Gorilla will always give you 5 days to authorize if it is deauthorized for 
any reason. Gorilla now will not ask you to authorize if there is a network (wireless) 
change to your computer. 

2. The Expand Stripboard option now supports 20” screens for Windows. 

3. The Update CUME command in the View menu now checks for inconsistencies in the 
budget and automatically fixes them. 

4. When adding a new account level line item, if the group number is not selected, the 
account will not be created, but will give a warning to choose a category. 

5. When creating a new character it is automatically created as an element in the 
Scheduling module, so you don’t have to “Convert the Character to an Element”. 

6. Saving the budget now properly saves In-Kind information. 

7. When showing Fringes detail in the budget, the screen would maximize to display white 
space. This has been fixed. 

8. Duplicating a Detail Line Item did not duplicate the attached fringe. This has been fixed. 
This used to possibly cause a Windows crash. 
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9. Duplicating an Account did not duplicate the attached fringes to the associated detail 
line items. This has been fixed. This used to possibly cause a Windows crash. 

10. When saving a stripboard scenario, Gorilla automatically updates your stripboard. 

11. When loading a schedule or a budget file the dialog box appears: “Load this 
schedule/budget to the existing project or create a new project for this 
schedule/budget?” Clicking on the New button did not load the .grs file properly. This 
button has been eliminated. 

12. If trying to authorize over the internet and a communications error message appears 
even if you are connected to the internet, it is very possible that Anti-Virus software is 
turned on which disables any incoming information from unknown servers. A message 
now appears that tells users to disable any Anti-Virus software before authorizing over 
the internet. 

13. If a production has 2 phases that overlap in shoot days (i.e., have the same dates), then 
when adding day breaks to the stripboard, an error will occur which will cause the End of 
Day Label to display incorrectly. This has been fixed both on the Stripboard and the 
printed Stripboard Reports. 

14. Stripboards did not print in color. This has been fixed. 

 
Fixes & Enhancements for Gorilla v3.0.5 

 

List of Fixes/Enhancements 
 

1. Delete Project would still allow even if Security was set not to delete a project. This has 
been fixed. 

2. When running a Shot List report, the stripboard will automatically update (if preference 
is on) to display the shots in shooting order. 

3. Expand Stripboard (3) added to display Stripboard/Breakdown Sheets and Shoot Days 
screens for 20” Theater Wide screens. 

4. Added the field Country to People records. 

5. The Crew List screen now displays the number of projects a crew member is attached to. 

6. The Art Department Reports now give you the option of printing Cast Members or hiding 
them. 

7. A new breakdown preference has been added called: Update Breakdown Sheets. If 
checked, every time you navigate from the Stripboard to the Breakdown Sheets screen 
the breakdown sheets will display a dialog asking if you want to update breakdown sheets 
before it does it. This is only useful with very long stripboards and you don’t want to 



 

 

constantly update the breakdown sheets because it will take longer. It is highly 
recommended to update the breakdown sheets before printing any scheduling reports. 

8. Saving the Schedule now saves: Ideas, Acts and Plot Points in the Story module. 

9. The Ratebook (Pro Edition only) had an additional 50 rates to reflect SAG Low-Budget 
contracts. 

10. The Show Error Log in the Save/Load screen now displays the proper errors if they occur 
when saving a file. 

11. You can now export transactions from the Accounting module to a separate file. 

12. Shoot Days Global in Budget module included calendar events and shoot days. This has 
been fixed. 

13. Other minor fixes have been made. 

 
Fixes & Enhancements for Gorilla v3.0.4 

 

List of Fixes/Enhancements 
 

1. In Detail Table View, you can now delete all detail line items for a single budget in one 
keystroke. 

2. After loading a .grs file (Schedule file) that Gorilla did not recognize as a Gorilla 
Schedule file, the program left you in a lost window. This has been fixed. 

3. When importing elements from an external source, you can now turn on the import map 
before importing to assist in the mapping of the elements into Gorilla. 

4. There is now a Clear Times button on the DPR (Daily Production Report) screen, that 
allows you to clear all times. 

5. The Meals Display box in the Scene/Cast Call Sheets would show “No Meals” over a First 
Meal and Second Meal labels. This has been fixed. 

6. The Scene/Cast Call Sheet now cap the elements and the group. 

7. Sometimes the correct elements would not show correctly on the Scene/Cast Call Sheet. 
This has been fixed. 

8. The Find All command in the Transactions module was not working properly. This has 
been fixed. 

9. In the Smart Entry for adding elements, you can now Use the Daily Rate to import the 
daily rate attached to the element directly to your detail line item. 
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10. The Values module for customizing Crew Titles has been enhanced and is easier to 
navigate through and to add crew titles. 

11. The checkmark to make a crew member active or inactive was not working in the Wizard 
screen. This has been fixed. 

12. In the Top Sheet of the budget module, creating a new line item in the Other section, did 
not work properly. This has been fixed. 

13. If you changed the captions on a budget they would only change in the Top Sheet report, 
not the Account Level or Detail reports. This has been fixed. 

14. Added the field Type to the Ratebook. Also updated drop-down lists to be more accurate. 

15. If you save a schedule or a budget file and the name of the file already existed on your 
hard drive, it created an endless loop. This has been fixed. 

16. When selecting a Producer and/or a Director name on the DPR, it only added that name 
to that particular shoot day which shows up on a DPR report. Now it adds that name(s) to 
the entire shoot. 

17. Widened the space on the Scene/Cast Call Sheet where elements are listed because 
sometimes the name of the element would scrunch up or down and you could not read 
the name of the element. 

18. Added a new expand stripboard option (Expand Stripboard 3) designed for 20” widescreen 
monitors. 

19. Added an Import All Groups and a Export All Groups to allow users to import/export all 
elements for a project from one Gorilla Schedule to another. 

20. When printing a Chart of Accounts report in the Budget and the Suppress Zero’s 
preference was checked, the report could not find the proper records. This has been 
fixed. 

 
Fixes & Enhancements for Gorilla v3.0.3 
 
List of Fixes 

 

5. When creating a new detail line item in the Budget the data from the AMT and the UNITS 
fields would not come in to the detail line item. This has been fixed. 

6. In 9-Column Stripboard display, the 2nd and the 9th window would not allow you to select 
multiple strips at once using the Shift-Click method. This has been fixed. 

7. The Scheduled Elements Report would not print. This has been fixed. 



 

 

8. In the Budget Balance Report and the Transaction Register, if you were to change 
currency symbols it would not show in the report. This has been fixed. 

9. The Find transaction button now works in the Transactions module. 

 
Fixes & Enhancements for Gorilla v3.0.2 
 
List of Fixes 

 

1. Move Production Phase did not work. This has been fixed. 

2. After removing a Split Scene, the found set of breakdown sheets was 0. Now, the found 
set for the project is found. 

3. When adding an element to multiple breakdown sheets (in the Elements 
Detail/Breakdown Sheets tab), blank lines were seen in the Select Breakdown Sheet pop-
up dialog box. This has been fixed. 

4. When adding elements directly onto a printable-breakdown sheet the progress bar would 
display “iiiiiiiiiiiiiii” [Windows platform only]. This has been fixed. 

5. When importing elements from an outside source, the category names in the list to select 
from had a black arrow next to it, implying to click on the arrow, which did nothing. The 
black arrows have been removed. 

6. When importing elements from an outside source, all elements for the project would be 
deleted. This has been fixed. 

7. When moving strips in 2-Column mode, you could not insert a strip above a day break if 
there were no strips above that day break. This has been fixed. 

8. When importing globals from an outside source, the values would not import properly. 
This has been fixed. 

9. Added the field “Theme” to the Find screen in the Film Festivals module. 

10. If you were to Cancel the Copy of a DPR day, it would still copy the day to another day. 
This has been fixed. 

11. If you were to disable security and update to a newer version of Gorilla, you could not 
log on because Security was disabled. Now, if you update, security is automatically 
turned on so you can initially log in, and then manually disable security. 

12. In the Security menu, the pull-down Main Menu under the Go menu now works. 

13. In 1-Column stripboard display, if you click Shift-Option (Macintosh) or Shift-Alt 
(Windows) on a strip, a detail window will now appear enabling you to edit the contents 
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of that breakdown sheet. You can then return to the same exact place you were on the 
stripboard. 

14. Upon exiting the program, Gorilla will check to see if the last stripboard was properly 
saved and display a warning, enabling you to save the board. 

15. When selecting a Local # from the Ratebook pop-down menu, you can now see the Local 
# and the Union name together. Prior to this, you would only see the Local #. 

16. When exporting globals, all globals for the project were selected to be exported. This has 
now been changed to only export globals for the selected budget. 

17. In the Globals screen, the New pull-down selection in the File menu now works. 

18. More than 700 up-to-date rates are now in the Ratebook! [Enhancement] 

19. Ability to export transactions from the Accounting module. [Enhancement] 

20. Ability to disable the check screen resolution warning right directly when the message 
appears instead of going into Preferences and disabling it there. 

21. The Globals pull-down menu is now active in the Account Title screen and does not 
conflict with the opening of the Gorilla Guide with the keyboard shortcut: Option-G or 
Alt-G. 

22. Added field Cost to the Elements screen, enabling you to attach a cost to each element. 
This figure can then be automatically imported into the budget using Gorilla’s Smart-
Entry feature. 

23. When using Quick Save and then clicking Cancel, the message appears “Schedule Saved”. 
This has been fixed. 

24. When attaching a name to the Profit Sharing table in Distribution of Profits, blank lines 
would appear above the names to be selected. This has been fixed. 

25. In the Value screen, the Exit Gorilla pull-down menu was not working [Windows only]. 
This has been fixed. 

26. The Cast Profile Report did not properly show all the representation fields for actors. 
This has been fixed. 

27. Added Fringe Total on all three budget reports. 

28. Changed the label Sub Total to Sub Total Percentages. 

29. Added Table View for Category Level [Budget]. 

30. Added Table View for Account Level [Budget]. 

31. Fixed the budget form: Feature Film Low Budget. 



 

 

32. Fixed the title of the budget form from AFC to ABC. 

33. In the 1-Column Stripboard, if you Shift-Option (Macintosh) or Shift-Alt (Windows) a strip, 
you can edit items for that strip directly on the screen. [Enhancement] 

34. Added new pull-down option in Budget Detail under the Edit menu: Add New 
Prep/Shoot/Wrap Line Item, which will create 3 detail line items at once. [Enhancment] 

35. Added Quick Save Schedule and Quick Save Budget pull-down menu items in the Projects 
module for easy access to Gorilla’s Quick Save feature. 

36. The Gorilla Guide has been updated (Revision 1.2). 

37. After deleting a found set of breakdown sheets in List View, day breaks would appear as 
blank lines in the list. This has been fixed. 

38. Sometimes when navigating from the Detail Level of the budget to the Account Level, no 
line items were found. This has been fixed. 

39. Added Import Map and built-in guide for importing budgets from an Excel spreadsheet. 
This could be done in previous versions, but was not explained on screen. 

40. The Calendar print-out on the second Friday was not displaying events associated with 
that day. This has been fixed. 

41. On the DPR Report, the Producer field and the Director field were swapped. This has 
been fixed. 

42. Budget navigation from category to accounts always went to the Above-The-Line section 
even if you were in the Production, Post-Production or Other tab. This has been fixed.  

43. If an account without an Account ID was deleted, all detail line items for that budget 
would also be deleted. This has been fixed. 

44. The following budget forms have been corrected: a) Disney Form, b) Fox TV Form, c) 
Universal Form. 

45. If selecting a breakdown sheet to add to a location, the pop-up window was also showing  
blank lines. This has been fixed. 


